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The charts address the adult protective services (APS) laws for each state, the District of 
Columbia, Guam, Puerto Rico, and the Virgin Islands.  This explanation and the charts refer to 
these jurisdictions generically as “state” or “states.”   

 
Unless otherwise indicated, this explanation (1) uses the term “abuse” generally to 

include abuse, neglect, and exploitation and (2) uses “elder abuse” to include elder abuse and 
adult abuse.  

 
CAUTION: It is unclear whether state mandatory reporting laws apply to federal 

employees.  Guidance should be sought from appropriate federal personnel. 
 
CAUTION: These charts are based only on the state APS laws; APS regulations were 

not reviewed.  It is important to recognize that there may be other state laws or regulations or 
federal laws or regulations that address the issues covered by these charts.   

 
NOTE: A few states have multiple laws.  Some of those states have separate elder 

protective services (EPS) laws and APS laws, and those laws are designated in the charts by 
following the state abbreviation with “EPS” or “APS”.  Some states have more than one APS 
law, and those laws are designated in the charts by following the state abbreviation with #1 or 
#2.  Unless otherwise indicated in this explanation or the charts, both APS and EPS laws will 
generally be referred to as APS laws.   
 
I.   Why We Developed These Charts 

 
“How many states have mandatory reporting?” and variations of “Who is required to 

report elder abuse?” are among the most frequently asked questions in the elder abuse field.  The 
answers to these questions are complex, as the laws governing reporting are very diverse in 
content and structure and extremely challenging to categorize and explain.  Nonetheless, 
knowledge of the reporting provisions in APS laws is critical for individuals who are mandated 
or who wish to report suspected elder abuse, members of professions and disciplines that 
collaborate with APS, and victims or people who are concerned about them.  Additionally, state 
and federal legislative staff, other policy makers, educators, researchers, and reporters often want 
to know what states have mandatory reporting and who is required to report their suspicions 
about elder abuse to APS.   
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II.   Detailed Explanation of the “Reporting Requirements in State Adult Protective 
Services Laws” Charts 

 
There are 19 charts in this series. They include one chart in Microsoft Word titled, 

“Reporting Requirements: Provisions and Citations in Adult Protective Services Laws, by State” 
(referred to as “provisions chart”), and 18 charts in Microsoft Excel3 titled, “Mandatory 
Reporters: Comparison Charts of Categories in Adult Protective Services Laws, by State” 
(referred to collectively as “categories charts”). 
 
 The charts are explained below.  A general description of the charts is followed by an 
explanation of how to read each.  
 

A. Reporting Requirements: Provisions and Citations in Adult Protective Services Laws, by 
State 
 
1. General Description of Chart 
 
This chart provides the reporting provisions in each state’s APS law that formed the basis 

for the categories charts.  These provisions govern reporting to APS by individuals who suspect 
elder abuse, but they also may address other situations.  For example, some statutes require APS 
personnel to cross-report cases to another agency, such as law enforcement or the agency that 
licenses and certifies long-term care facilities.  Some statutes require other agencies that receive 
reports of abuse to make reports to APS.  Statutes also may govern other issues related to 
reporting, such as time standards for investigating a report or whether APS is responsible for 
investigating reports about abuse of long-term care facility residents.  The provisions chart 
includes all provisions related to reporting in the state APS laws, but the categories charts 
only reflect the provisions governing who must report to APS.  To help readers track 
between the provisions chart and the categories charts, the portions of the statutory 
provisions that indicate who is mandated to report to APS are highlighted in yellow. 
 

The list of mandatory reporters contained in the categories charts may be more expansive 
and detailed than what is provided in the statutory provisions, however.  This is because some 
state APS laws include categories of mandatory reporters by making reference to other statutes.  
For example, Georgia’s law states that “an employee of a financial institution, as defined in Code 
Section 7-1-4” is a mandatory reporter.  To provide an accurate list of mandatory reporters, it 
was necessary to research, analyze, and include the results of those other statutory provisions in 
the categories charts.  For Washington and Wisconsin, however, analysis of other statutes 
resulted in irrelevant information.  For those states it was necessary to analyze statutes governing 
licensing of entities and facilities by other state agencies.  Those statutes contained lengthy lists 
of entities and facilities, some of which did not seem relevant to elder abuse victims.  Those 
entities and facilities that did seem relevant were included in the appropriate categories, but those 
that did not were simply listed at the end of the categories chart in categories labeled 
“Washington” and “Wisconsin.”  
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2. How to Read the Chart 
 
As noted above, the provisions chart includes all provisions related to reporting in the 

state APS laws, but the categories charts only reflect the provisions governing who must report 
to APS.  To help readers track between the provisions chart and the categories charts, the 
portions of the statutory provisions that indicate who is mandated to report to APS are 
highlighted in yellow. 

 
If a state has more than one APS law or separate EPS and APS laws, then those situations 

are clearly identified in the left column where the state is indicated.  
 
The right column includes the statutory citations, which are provided before the statutory 

provision.  Some laws have multiple sections governing reporting.    In those situations, a line 
divides each section of the law and a citation is provided for each section. 
 

B. Mandatory Reporters: Comparison Charts of Categories in Adult Protective Services 
Laws, by State 
 
1. General Description of Charts 

 
The many types of mandatory reporters were clustered into 17 broad categories.  This 

document, which is in Microsoft Excel, contains a master chart that includes all 17 categories 
and a separate chart for each of the 17 categories described below.   

 
a. To provide context, every chart begins with the “Mandatory Reporting (All 

Jurisdictions)” category.  This category has five subcategories:  
1. “No Mandatory Reporting,”  
2. “Limited Mandatory Reporting,”  
3. “Any Person,”  
4. “Any Person with Qualifications/Circumstances,” and 
5. “Certain Professionals or Personnel as Mandatory Reporters.” 

 
If a state is listed in the “No Mandatory Reporting” category, it means that no one 
is mandated to report to APS; in other words, reports are voluntary.     

  
Three states are listed in the “Limited Mandatory Reporting” category.  Those 
states have made a distinction between the circumstances that APS must 
investigate and the limited circumstances that must be reported to APS.  (For 
more information about the circumstances that APS must investigate, see the 
“Threshold Eligibility Criteria for Adult Protective Services” chart series at 
http://www.ncea.aoa.gov/NCEAroot/Main_Site/Find_Help/APS/Analysis_State_Laws.aspx).  
In Illinois and Wisconsin mandatory reporting is only necessary if the person 
thought to be abused is unable to seek help or make a self-report to APS (this is a 
gross simplification of the statutory provisions, particularly for Wisconsin, so see 
the provisions chart for details).  In Pennsylvania mandatory reporting is 
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necessary only if the person thought to be abused is “receiv(ing) care, services, or 
treatment in or from a facility.” 
 
If a state is listed in the any person category, it means that everyone who suspects 
abuse is a mandated reporter.   
 
Three states are listed in the any person with qualifications/circumstances 
category.  These states treat any person who meets certain qualifications or 
circumstances as a mandated reporter.  For example, in South Carolina any person 
who has “actual knowledge” of abuse is a mandatory reporter.  Contrast this with 
the “any person” states, in which any person who simply suspects abuse is a 
mandatory reporter.  The difference between this “any person with 
qualifications/circumstances” category and the “limited mandatory reporting” 
category is that the former focuses on the reporter’s circumstances, whereas the 
latter focuses on the victim’s circumstances. 
 
A majority of the states designate certain professionals or personnel as 
mandatory reporters.    
 
A few states require “any person” or “any person with qualifications/ 
circumstances” to report, but also designate certain professionals or personnel as 
mandatory reporters.  To accurately reflect the statutory provisions, those states 
are listed in the “any person” or “any person with qualifications/ circumstances” 
categories, but are also listed in the “certain professionals listed” category.   
 
CAUTION: Many of the statutory provisions contain exceptions to, and 
limitations on, the mandatory reporting requirements.  These exceptions and 
limitations vary widely.  For example, Wisconsin, a limited mandatory reporting 
state, has a broad exception to its limited mandatory reporting in both of its laws:  
“if the person believes that filing a report would not be in the best interest of the 
elder adult at risk.”  Many provisions apply only to professionals or others who 
suspect abuse in the course of their work.  Actually, it can generally be assumed 
that the requirements that professionals and personnel report relate to abuse they 
suspect in the course of their work unless they are in a state that requires “any 
person” to report.  That widespread limitation is only indicated in the “any person 
with qualifications/circumstances” category, where it applies to two of the three 
states listed in that category.  Unlike the other categories, the failure to include the 
limitation in that category would result in misinterpretation of the statute (i.e., 
without indicating the limitation, those two states would appear to be “any 
person” states, rather than “any person with qualifications/circumstances” states).  
There may be other specific limitations, usually pertaining to privileged 
relationships between a professional and the older person about whom abuse is 
suspected.  Readers cannot rely solely on the categories charts to learn who 
the mandatory reporters are and under what circumstances they must 
report.  It is imperative that the categories charts be interpreted in 
conjunction with the statutory provisions chart and, in some circumstances, 
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the Types of Abuse charts or the Threshold Eligibility charts at 
http://www.ncea.aoa.gov/NCEAroot/Main_Site/Find_Help/APS/Analysis_State_Laws.aspx). 

 
b. The “Any Person with Qualifications/Circumstances” category provides the 

statutory provisions for the three states listed in that category in the Mandatory 
Reporting section.   

 
c. Provisions are included in the “Broad/Non-Specific Categories” only if we could 

not determine in what other category to place the provision or the provision could 
have been placed in multiple categories.  An example of the former is “individual 
provider.”  An example of the latter is “Employees or officers of any public or 
private agency or institution providing social, medical, hospital or mental health 
services, including financial assistance.” 

 
d. The “Broad/Non-Specific Categories of Health Professionals (Physical/Dental/ 

Mental Health Care Providers)” category includes those health-related categories 
that lacked sufficient specificity to allow placement in one of the subsequent 
specific categories of health-related professionals.  Examples include “health care 
practitioner” and “employee of a mental health agency.” 

 
e. The “Specific Categories of Physical Health Professionals” are self-explanatory. 

 
f. The “Specific Categories of Mental Health Professionals” are self-explanatory. 

 
g. The “Social Workers” category is self-explanatory. 

 
h. The “Care Providers” category includes caregivers/caretakers (which may include 

laypersons as well as professionals or personnel); owners, operators, managers, 
administrators, staff, or volunteers of various types of facilities or programs, 
including such things as nursing homes, hospices, or numerous others.  Certainly 
some of the staff of those facilities or programs might be health care 
professionals, but as some of the staff might not be health care professionals and 
the provisions did not draw that distinction, we included those facilities and 
programs in the “Care Providers” category. 

 
i. The “Human/Social Services Agency Staff, Volunteers, and Contractors” 

category includes both public and private sector professionals.  NOTE: While this 
category could include the Long-Term Care Ombudsman Program (LTCOP), 
those professionals are listed under the “Advocates” category because the Older 
Americans Act, which mandates the LTCOP, provides that the LTCOP is to act as 
an advocate for long-term care facility residents.   

 
j. The “Advocates” category includes subcategories that either use the word 

“advocate” or are domestic violence programs (which serve as victim advocates).  
NOTE: As indicated above, the LTCOP professionals are included in this 
category. 
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k. The “Criminal Justice System Personnel” category is self-explanatory.  Coroners 

and medical examiners are included here, rather than in the “Broad/Non-Specific 
Categories of Health Professionals” category. 

 
l. The “Fiduciaries (Attorneys, Legal Representatives, Guardians, Conservators, 

Trustees)” category is self-explanatory.  NOTE: Some of the professionals listed 
in the “Financial Professionals” category, such as accountants, may also be 
fiduciaries. 

 
m. The “School Personnel” category is self-explanatory. 

 
n. The “Financial Professionals” category is self-explanatory.  NOTE: Some of the 

professionals included in this category, such as accountants, may also be 
fiduciaries. 

 
o. The “Miscellaneous” category contains professions that are specifically listed in 

the statutes but that don’t fit into any other categories.  Examples include clergy, 
funeral home personnel, and fire department personnel. 

 
p. The “Categories Listed Under ‘An Employee of Any Entity That Is Licensed, 

Certified, or Approved By or Registered With The Department [of Health And 
Family Services]’ in WI #1 And WI #2 Not Included in the Chart Above” is self-
explanatory.  See the explanation above in Section II.A.1 about why these 
Wisconsin provisions are included. 

 
q. The “Categories Listed Under a ‘Health Care Provider Subject to Chapter 18.130 

RCW’ in WA Not Included in the Chart Above” is self-explanatory.  See the 
explanation above in Section II.A.1 about why these Washington provisions are 
included. 

  
CAUTION: These charts reflect substantial consolidation of the tremendously diverse 

statutory categories of mandatory reporters (initial statutory analysis resulted in almost 500 
categories).  Yet the chart still contains many categories and subcategories because seemingly 
minor differences in wording from one state’s law to another may have significant meaning.  
Further consolidation would necessitate interpretation of additional statutes, regulations, and 
court cases that goes far beyond the scope of the project for which these charts were developed.   

 
2. How to Read the Charts 

 
The title and disclaimer page applicable to all 18 charts is located in the first worksheet4 

of this Microsoft Excel document.  The charts are provided in the subsequent 17 worksheets, the 
titles of which are abbreviations of the underlined category names listed above.  Those 17 
worksheets are:   
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a. Master  

b. Mandatory Reporting  

c. Any Person (limited) 

d. Broad Categories 

e. Broad Categories – Health  

f. Specific Categories – Physical  

g. Specific Categories – Mental  

h. Social Workers 

i. Care Providers 

j. Human Social Services 

k. Advocates  

l. Criminal Justice 

m. Fiduciaries 

n. School Personnel  

o. Financial Professionals  

p. Miscellaneous  

q. Wisconsin 

r. Washington   

The title of each worksheet appears on its worksheet tab on the tab bar at the bottom left 
corner of the screen.  To access a worksheet chart, click on its worksheet tab.  If you do not see 
the worksheet tab that you want, click the tab scrolling arrows (which are to the left of the 
worksheet tabs) until the tab you want is displayed and then click the tab. 

 
To maximize space in the column headers, state postal abbreviations are used instead of 

state names.  A list of those abbreviations is at http://www.usps.com/ncsc/lookups/abbr_state.txt 
 
Colored columns are used to designate certain reporting subcategories.  If a state is listed 

in the voluntary reporting category, its column is highlighted in pink.  If a state is listed in the 
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any person category, meaning that everyone is a mandated reporter, its column is highlighted in 
yellow.  A few of the “any person” states also list certain professionals or personnel as 
mandatory reporters in their laws.  For those states, the column is highlighted in yellow and all of 
the appropriate categories are indicated in the categories chart. 

 
This chart has categories (see the 18 categories listed above), subcategories, and sub-

subcategories.  The categories are shaded in dark gray to help them stand out.  Whether a 
subcategory is shaded and contains X marks depends on whether it has sub-subcategories.  If a 
subcategory has no sub-subcategories, then its background will be white and it will have X 
marks indicating which states include those professionals or personnel as mandatory reporters.  If 
a subcategory has sub-sub categories, then it is shaded in light gray and will not have any X 
marks.  Instead, only the sub-subcategory listings will have X marks.   

 
The sub-subcategory listings generally paraphrase the various statutory provisions that fit 

into that sub-subcategory.  In some instances, however, it was impossible to paraphrase and 
instead we used the exact wording of the statutory provisions (see, for example, the many Illinois 
provisions that refer to professionals or their delegates licensed under a certain Act).  

 
Many of the provisions in the Illinois and Minnesota statutes include professionals’ 

delegates among the mandatory reporters.  If the sub-subcategory listing is copied from a 
statutory provision that includes the word “delegate,” then we simply indicated that category 
with an X mark.  If, however, the sub-subcategory listing is paraphrased and does not include the 
word “delegate,” the chart will have a D rather than an X to indicate that the statute includes a 
delegate as a mandatory reporter.    
 
III.   Technical Issues about Printing Four of the Charts in Microsoft Excel  
 
 Because of their large size, the following four worksheets in Microsoft Excel cannot be 
printed in their entirety:   

1. Master 
2. Broad Categories – Health 
3. Specific Categories – Physical, and  
4. Care Providers. 

 
To print a portion of these worksheets, you must first define the print area5 for the 

worksheet you want to print.  (For example, if you are only interested in mandatory reporting for 
a particular state or a particular profession you need only define the print area for that particular 
state or profession.)   

 
To define the print area, follow these three steps: (1) on the “View” menu, click “Page 

Break Preview”; (2) select the area you want to print, and (3) on the “File” menu, point to “Print 
Area,” and then click “Set Print Area.”  Be sure to keep paper size and margins in mind when 
defining the print area.  

  
 Now that the worksheet has a defined print area, you can print the document by following 
these steps: (1) on the “File” menu, click “Print,” (2) the “Print” dialogue box will open, (3) 
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change the “Print What” setting (on the lower left side of the dialogue box) from “Active 
sheet(s)” to “Selection,” and (4) Click “OK.”  
 

To learn more about printing in Microsoft Excel including paper size and margins, visit 
http://office.microsoft.com/en-us/excel/CH062527841033.aspx  
 
IV.   If You Find an Error 
 

We strived to be consistent in our interpretation and categorization of the statutes.  
Despite our best efforts, we may have made errors.  It is also possible that APS or other 
professionals interpret a statute differently than we did or there are state regulations or policies 
that lead to a different interpretation.  Additionally, state laws may have changed since 
December 31, 2006.  If you think we erred or your state has a regulation or policy that leads to a 
different interpretation, please contact Lori Stiegel of the American Bar Association Commission 
on Law and Aging at lstiegel@staff.abanet.org or 202-662-8692. 
 
 
                                                 
1 The views expressed herein have not been approved by the House of Delegates or the Board of Governors of the 
American Bar Association and, accordingly, should not be construed as representing the policy of the American Bar 
Association. 
2 This document was completed for the National Center on Elder Abuse and supported in part by a grant, No. 
90AM2792, from the Administration on Aging, U.S. Department of Health and Human Services.  Grantees 
undertaking projects under government sponsorship are encouraged to express freely their findings and conclusions.  
Therefore, points of view or opinions do not necessarily represent official Administration on Aging policy. 
3 If you do not have Microsoft Excel, visit http://www.microsoft.com/downloads/details.aspx?FamilyId=C8378BF4-
996C-4569-B547-75EDBD03AAF0&displaylang=en to download Excel Viewer 2003.  With Excel Viewer 2003, 
you can open, view, and print Excel worksheets, even if you don't have Excel installed on your computer. You can 
also copy data from Excel Viewer 2003 to another program. However, you cannot edit data, save a worksheet (see 
following footnote), or create a new worksheet. This download is a replacement for Excel Viewer 97 and all 
previous Excel Viewer versions. 
4 A worksheet is the primary document that is used in Excel to store and work with data.  
5 A defined print area is the only area Microsoft Excel will print.   


